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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

LOGO! – 
 
 

The Original! 

 هقذهِ
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

در جسییات آى در یک ًگاُ! لَگَ  

 ًػة ٍ سین تٌذی
  هًَتاص ٍ ًػة دستگاُ
  ًػة ٍ جذا کزدى دستگاُ در هحل
  اتػال تِ تزق
  اتػال ٍرٍدی ّا ٍ خزٍجی ّا
 رٍضي ضذىرفتار   

 تَاتع
  تَاتع پایِ
  تَاتع خاظ

 عولیات رٍی خَد دستگاُ
  کٌتزل عولیات
  اٍلیي تزًاهِ
 در حالت اجزا تزًاهِ! لَگَ  
 !تٌظیوات لَگَ  

LOGO! Soft Comfort 5.0 
  ًػة تزًاهِ
  تَاتع راٌّوا
   درک قذم تِ قذم فزاهیي هعوَلی
  دیگز گشیٌِ ّا

 هثال کارتزدی
  کٌتزل یک دستگاُ ضیطِ پزکي 

 

 هقذهِ
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 ًصب ٍ سین بٌذی

N 

K2  

L1 

K2  

I :  

0..  123456789 

1..0123456789 

2..01234  

4 

 ًػة ٍ سین تٌذی
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

!ساختار سخت افساری لَگَ  

دیجیتال ٍرٍدی 24 :آرایص حذاکثز   آًالَگٍرٍدی  8 + 
 خزٍجی آًالَگ 2 + خزٍجی دیجیتال 16 + 

 اتػال تزق

 هحل اتػال تغذیِ تزای ٍاحذ ّای تَسعِ

تَقف/ اجزا   

 4 خزٍجی

  4 ٍرٍدی 

 ٍرٍدی 8

کلیذ تزای اتػال 
 تزق

 4خزٍجی

غفحِ 
 ًوایص

 تضاد رًگ 
 قاتل کٌتزل

The internal 
qualities 

count 

 ًػة ٍ سین تٌذی
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

  ًػة

:رٍی ریل! تزای سَار کزدى لَگَ  

را در ریل قزار دّیذ! لَگَ   

را تا حذی رٍی ریل تلغشاًیذ تا کاهلا پطت لَگَ در ریل قزار گیزد! لَگَ  

سادُ ٍ هذٍل تَسعِ کاٍر اتػال را تزداریذ! در سوت راست لَگَ  

پایِ را در تالا قزار دّیذ! هذٍل دیجیتال لَگَ  

 هذٍل دیجیتال را تِ سوت چپ تلغشاًیذ

 اس یک پیچ گَضتی استفادُ ًوَدُ ٍ هذٍل را در سوت چپ در هحل ًْایی اش قزار دّیذ

1

2

3

4

5

6

!ًصب ٍ جذا سازی لَگَ   

 ًػة ٍ سین تٌذی
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

!ًصب ٍ جذا سازی لَگَ  

 جذا ساسی

! :تزای جذا کزدى لَگَ  

 تا استفادُ اس یک پیچ گَضتی لغشًذُ را تِ پاییي ٍ راست هٌتقل کٌیذ
 هذٍل تَسعِ را تعِ راست تلغشاًیذ ٍ

 یک پیچ گَضتی را در سَراخی کِ در پاییي اًتْای هحل ًػة ٍجَد دارد فزٍ تزدُ ٍ آًزا تِ راست فطار دّیذ
 هذٍل تَسعِ را تِ راست تلغشاًیذ

 قذهْای تالا را تزای هذٍل پایِ تکزار کٌیذ 

1

2

1

2

3

4

A B

 ًػة ٍ سین تٌذی
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

:تِ تزق! اتػال لَگَ  

ML+ I1 I2 I3 I4 I5

L1L+

NM

I1 I2 I3 I4L1 N

:(تَغیِ هی ضَد) حفاظت تا فیَس   

12/24 RC...: 0.8 A 
24: 2.0 A 

تزای حفاظت در تزاتز تغییزات ضذیذ ٍ ًاگْاًی اس  
درغذ تالا تز ٍلت ًاهی 20یک ٍریستَر تا ٍلت   

:تا تزق هتٌاٍب!لَگَ :تا تزق هستقین!لَگَ   

!لَگَ سین بٌذی  

 ًػة ٍ سین تٌذی
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

! لَگَ اتصال ٍرٍدی ّا بِ  

!.اتػال سٌسَرّا تِ لَگَ   
:سٌسَرّای کارتزدی ضاهل    

 ... .ضاسی ّا ٍکلیذّا ٍیا سَیچ ّای فتَ الکتزیک ٍ   

 ٍلت 10تا  0سٌسَرّای دها ٍفطار ٍ غیزُ تا خزٍجی    

 2هیلی آهپز تِ ٍرٍدی ّای آًالَگ هاصٍل ای ام  20تا 0یا دستگاُ ّایی هٌاسة تا جزیاى خزٍجی   

  یا اتػال تِ دٍ یا تیطتز تزهَهتز هقاٍهتی تا دٍ یا سِ سین 

دستکاُ ّای ٍرٍدی تایذ سهیي هطتزکی 
 داضتِ تاضٌذ

LOGO! 12/24 ... 
L+ 

M L+ I1 I2 I3 I4 I5 I8 

M 

ٍرٍدی ّا در دٍ گزٍُ دستِ تٌذی ضذُ اًذ 
تای آًْا در یک گزٍُ جا گزفتِ اًذ 4ٍ  

LOGO! 230 ... 

L1 

N 

N L1 I1 I2 I3 I4 I5 I6 

L3 
L2 

تا اتػال دٍسیوِ اهکاى تػحیح در اًذاسُ گیزی  
 ٍجَد ًذارد ٍلی در اتػال سِ سیوِ هوکي است

2-wire technology 3-wire technology 

 ًػة ٍ سین تٌذی
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

!لَگَ اتصال خرٍجی ّا بِ  

ضوا هی تَاًیذ خزٍجی ّای 
:هتفاٍتی ضاهل   
 چزاغْا 
 هَتَرّا 
 سَیچ ّا 
 ُغیز 

تا خزٍجی ! لَگَ
 تزاًشسیتَری

تا خزٍجی رلِ ای! لَگَ  

آهپز 0.3هاکشیون جزیاى تزای خزٍجی   

آهپز 10هاکشیون جزیاى تزای خزٍجی   

آهپز 5ٍ تزای هذٍل تَسعِ    

DM8 24 

Q5 M Q6 M 

load load 

Q1 M Q2 M 

Q2 Q1 
1 2 1 2 

Q5 
1 2 

Q6 
1 2 

DM8...R 

load load 
N M 

1 

 ًػة ٍ سین تٌذی
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

!لَگَ اتصال خرٍجی ّا بِ  

تا خزٍجی آًالَگ! لَگَ  

ضوا هی تَاًیذ دستگاّْای  
هتفاٍتی ضاهل هَارد سیز را تِ 

:خزٍجی ٍغل کٌیذ  
  ُهثذل فزکاًس تزای کٌتزل را
 اًذاسّا
 دیگز ٍرٍدیْا تا اهپذاًس تالا 

  

 اخطار!

خرٍجی ّا ًبایذ بار 
ضًَذ هاکسیون 
  0.2جریاى خرٍجی 

  آهپر است

 اتػال سهیي

 هقطع عزضی
 ریل

 ًػة ٍ سین تٌذی
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

:ٍقتی رٍضي هی ضَد ٍابستِ است بِ! عکس العول لَگَ  

  آیا برًاهِ ای در حافظِ داخلی هَجَد ّست؟
 یا
  آیا کارت حافظِ هتصل ضذُ است؟

ّیچ برًاهِ ای در کارت ٍ حافظِ 
 دستگاُ هَجَد ًیست

برًاهِ ای در کارت یا دستگاُ 
 هَجَد است

!اخطار  

اگر در دستگاُ برًاهِ ای باضذ ٍ کارت را ٍارد 
کٌین بِ هحض رٍضي ضذى دستگاُ برًاهِ 

کارت در دستگاُ کپی ضذُ ٍ برًاهِ در درٍى 
 حافظِ داخلی دستگاُ پاک هی ضَد

LOGO! 

> Program 

Card.. 

Setup.. 

Start 

s 

LOGO! 

No Program 

Press ESC 

s ًػة ٍ سین تٌذی 
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

تاتع پایِ 8  هثال کاربردی  

 تَابع پایِ

AND AND  
(edge) 

NAND NAND  
(edge) 

OR NOR XOR NOT 

The 
internal 
qualities 

count 

 تَاتع



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
 A&D AS, 02/2006, Chart 13 

    © Siemens AG 2006  -  Subject to change without notice 

 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

AND تابع 

هیطَد کِ ّوِ ٍرٍدی  1خزٍجی ایي تاتع سهاًی 
تاضٌذ 1ّا   

اگز یکی اس ٍرٍدی ّا ٍغل ًثاضذ تِ غَرت 
فزؼ هی ضَد 1خَدکار   

:جذٍل درستی ایي تاتع  

تا یک ًگاُ تِ هذار هعادل هی تَاى گفت کِ ٍقتی لاهپ رٍضي است کِ کلیذ ّای 
حالت ٍرٍدی ٍ خزٍجی ٍاتستِ تِ ّن ّستٌذ.تستِ تاضٌذ 1ٍ2ٍ3  

هذار هعادل گیت در رٍتزٍ رسن ضذُ است ٍدر یک کلام هی تَاى گفت کِ ٍقتی چزاغ 
.رٍضي است کِ ّز سِ کلیذ تستِ تاضٌذ   

:ضوای ایي گیت در سیز آهذُ است  

یک هذار سزی تا کٌتاکت 
 ّای تاس

& S1 

S2 

x 

H1 

AND 

S3 

S2 

S3 

H1 

S1 

Input 3 Output 

0 0 0 0 

0 0 1 0 

0 1 0 0 

0 1 1 0 

1 0 0 0 

1 0 1 0 

1 1 0 0 

1 1 1 1 

Input 2 Input 1 

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

هیطَد کِ یکی اس  1خزٍجی ایي تاتع سهاًی 
تاضذ 1ٍرٍدی ّا   

اگز یکی اس ٍرٍدی ّا ٍغل ًثاضذ تِ غَرت 
فزؼ هی ضَد 0خَدکار   

  یا2یا 1با یک ًگاُ بِ هذار هعادل هی تَاى گفت کِ ٍقتی لاهپ رٍضي است کِ کلیذ ّای 
حالت ٍرٍدی ٍ خرٍجی از ّن هستقل ّستٌذ. بستِ باضٌذ3  

ٍدر یک کلام هی تَاى گفت کِ ٍقتی چراغ رٍضي است کِ حذاقل یکی از سِ کلیذ بستِ 

:ضوای ایي گیت در زیر آهذُ است. باضٌذ   

OR تابع 

:عجذٍل درستی ایي تات  

هذار هَاسی تا کٌتاکت ّای 
 تاس

> S1 

S2 

S3 
H2 

OR 

x 

S1 S2 

H2 

S3 

Input  3 Output  

0 0 0 0 

0 0 1 1 

0 1 0 1 

0 1 1 1 

1 0 0 1 

1 0 1 1 

1 1 0 1 

1 1 1 1 

Input  2 Input  1 

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 ANDبا تریگرلبِ 

تاضٌذ ٍ  1هیطَد کِ ّوِ ٍرٍدی ّا  1خزٍجی ایي تاتع سهاًی 
.تَدُ تاضذ 0حذاقل یکی اس ٍرٍدی ّا در سیکل قثل   

فزؼ هی  1اگز یکی اس ٍرٍدی ّا ٍغل ًثاضذ تِ غَرت خَدکار 
 ضَد

 ANDبا تریگرلبِ 

S1 

S2 

S3 

H2 

S1 

S2 

H2 

S3 

 ضوارًذُ الکترٍدیٌاهیکی

5 1 6 0 

& S1 

S2 

x 

H2 
S3 

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

با یک ًگاُ بِ هذار هعادل هی تَاى گفت کِ ٍقتی لاهپ خاهَش است کِ کلیذ ّای 
.باز باضٌذ1ٍ2ٍ3  

.هذار هعادل گیت در رٍبرٍ رسن ضذُ است  

.ٍدر یک کلام هی تَاى گفت کِ ٍقتی چراغ خاهَش است کِ ّوِ سِ کلیذ باز باضٌذ  

:ضوای ایي گیت در زیر آهذُ است  

NAND (not-AND) تابع 

هیطَد کِ ّوِ ٍرٍدی ّا  1خزٍجی ایي تاتع سهاًی 
تاضٌذ 0  

اگز یکی اس ٍرٍدی ّا ٍغل ًثاضذ تِ غَرت 
فزؼ هی ضَد 1خَدکار   

 

جذٍل درستی ایي  
:تاتع  

هذار هَاسی تا کٌتاکت ّای 
 تستِ

S1 S2 S3 

H2 

& S1 

S2 

S3 
H2 

NAND 

x 

Input  3 Output  

0 0 0 1 

0 0 1 1 

0 1 0 1 

0 1 1 1 

1 0 0 1 

1 0 1 1 

1 1 0 1 

1 1 1 0 

Input  2 Input  1 

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

با لبِ تریگر  NAND 

S1 

S2 

S3 

H2 

 0هیطَد کِ حذاقل یکی اس ٍرٍدی ّا  1خزٍجی ایي تاتع سهاًی 
.تَدُ تاضذ 1تاضٌذ ٍ حذاقل یکی اس ٍرٍدی ّا در سیکل قثل   

فزؼ هی ضَد 1اگز یکی اس ٍرٍدی ّا ٍغل ًثاضذ تِ غَرت خَدکار   

 ضوارًذُ الکترٍدیٌاهیکی

 NAND با تریگرلبِ

S1 S3 S3 

H2 

5 1 6 0 

& S1 

S2 

S3 
H2 

x 

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

تا یک ًگاُ تِ هذار هعادل هی تَاى گفت کِ ٍقتی لاهپ خاهَش است کِ کلیذ ّای  
تاس تاضٌذ3 یا2یا 1  

.هذار هعادل گیت در رٍتزٍ رسن ضذُ است  
ٍدر یک کلام هی تَاى گفت کِ ٍقتی چزاغ خاهَش است کِ یکی اس سِ کلیذ تاس 

.تاضٌذ  
:ضوای ایي گیت در سیز آهذُ است  

NOR (not-OR) تابع 

 0هیطَد کِ ّوِ ٍرٍدی ّا  1خزٍجی ایي تاتع سهاًی 
 تاضٌذ

 0اگز یکی اس ٍرٍدی ّا ٍغل ًثاضذ تِ غَرت خَدکار 
 فزؼ هی ضَد

یک هذار سزی تا کٌتاکت 
 ّای تستِ

:جذٍل درستی ایي تاتع  

NOR 

>1 S1 

S2 

S3 
H1 

x 

S1 

S2 

H1 

S3 

Input  3 Output  

0 0 0 1 

0 0 1 0 

0 1 0 0 

0 1 1 0 

1 0 0 0 

1 0 1 0 

1 1 0 0 

1 1 1 0 

Input  2 Input  1 

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

XOR تابع 

هیطَد کِ ّوِ ٍرٍدی ّا حالت  1خزٍجی ایي تاتع سهاًی 
اگز یکی اس ٍرٍدی ّا ٍغل ًثاضذ  هتفاٍت داضتِ تاضٌذ

فزؼ هی ضَد 0تِ غَرت خَدکار   

XOR 

تا یک ًگاُ تِ هذار هعادل هی تَاى گفت کِ ٍقتی لاهپ رٍضي است کِ تٌْا یکی اس 
.سَیچ ضًَذ2یا 1کلیذ ّای   

. هذار هعادل گیت در رٍتزٍ رسن ضذُ است  
.سَیچ ضًَذ2یا 1ٍقتی لاهپ رٍضي است کِ تٌْا یکی اس کلیذ ّای   

:ضوای ایي گیت در سیز آهذُ است   

:جذٍل درستی ایي تاتع  

Input  2 Output  

0 0 0 

0 1 1 

1 0 1 

1 1 0 

Input  1 

=1 S1 

S2 

H1 

S1 

S2 

H1 

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

NOT تابع 

تاضذ ایي گیت ٍرٍدی را هعکَس هی  0است کِ ٍرٍدی  1خزٍجی ٍقتی 
دیگز ًیاسی تِ کٌتاکت تستِ ! کٌذ هشیت ایي گیت آى است کِ در لَگَ

ٍضوا تِ راحتی هی تَاًیذ اس یک کٌتاکت تاساستفادُ ًوَدُ ٍآى را تا  ًیست
 یک گیت تِ کٌتاکت تستِ تثذیل کٌیذ 

فزؼ هی ضَد 1اگز یکی اس ٍرٍدی ّا ٍغل ًثاضذ تِ غَرت خَدکار   

NOT 

1 

S1 H1 

تا یک ًگاُ تِ هذار هعادل هی تَاى گفت کِ ٍقتی لاهپ رٍضي است کِ کلیذ 
.تستِ ًثاضذ  

.هذار هعادل گیت در رٍتزٍ رسن ضذُ است  

 ضوای ایي گیت در سیز آهذُ است

:جذٍل درستی ایي تاتع  

Output  

0 1 

1 0 

Input  1 

S1 

H1 

K1 

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

تاخیری رٍضي ضذىتایور  

 تَغیف تاتع

درٍاقع خزٍجی ٍرٍدی را تا  .خَاّذ ضذ 1تَدُ تاضذ تعذ اس هذت تاخیز خزٍجی  1اگز ٍضعیت تزیگز تزای هذتی طَلاًی 
.ضَد 0خَاّذ ضذ ّزگاُ تزیگز  0یک تاخیز سهاًی دًثال هیکٌذخزٍجی   

ضَد تایوز ریست هی ضَد 0اگز ٍضعیت ٍرٍدی تزیگز قثل اس اتوام تایوز تاخیز   

 

در یک ًگاُ هی تَاى گفت کِ هَتَر سهاًی رٍضي هی ضَد کِ تایوز تاخیزی هذت  
.سهاى تاخیزش تِ پایاى تزسذ  

.هذار هعادل گیت در رٍتزٍ رسن ضذُ است  

 هَتَر سهاًی رٍضي هی ضَد کِ تا یک تایوز تٌظین ضذُ تِ سهاى هٌاسة تزسذ

 ضوای ایي گیت در سیز آهذُ است

S1 

K1 

K1 

M 

 :دیاگرام

Trg 

Q 

Ta 

T T 

 (تایوز فعال)

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 تَغیف تاتع

تاقی هی هاًذ  1هیزٍد تایوز فعال هی ضَدخزٍجی  0تِ  1هی ضَد ٍقتی تزیگز اس 1هیطَد خزٍجی فَرا  1ٍقتی تزیگز 
هیطَد ٍقتی ٍرٍدی تزیگز تغییز ٍضعیت داد تایوز ریست هی ضَد  0ٍقتی تایوز تِ هقذار هعیي ضذُ رسیذ خزٍجی 

.ٍرٍدی ریست هی تَاًذ تایوز ٍ خزٍجی را ریست هیکٌذ  

 تایور با خاهَضی تاخیری

در یک ًگاُ هی تَاى گفت کِ هَتَر سهاًی خاهَش هی ضَد کِ تایوز تاخیزی هذت 
.سهاى تاخیزش تِ پایاى تزسذ  

.هذار هعادل گیت در رٍتزٍ رسن ضذُ است   

 هَتَر سهاًی خاهَش هی ضَد کِ تا یک تایوز تٌظین ضذُ تِ سهاى هٌاسة تزسذ
 ضوای ایي گیت در سیز آهذُ است

S1 

K1 

K1 

M 

 (تایوز فعال)

Trg 

Q 

Ta T 

R 

T 

 :دیاگرام
 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 تایور با رٍضي ٍخاهَش ضذى تاخیری

:تا یک ًگاُ تِ هذار هی تَاى گفت کِ   

 تستِ هیطَد کٌتاکت تا تاخیز تستِ هی ضَد ٍهَتَر فعال  1ٍقتی کلیذ 
  هی ضَد

 ٍقتی کلیذ تاس هی ضَد کٌتاکت تا تاخیز تاس هیطَد ٍ هَتَر خاهَش هی 
.ضَد  

 ایي تاتع خاهَش ٍ رٍضي ضذى تا تزًاهِ است
در سیز آهذُ است تاتع ضوای ایي   

 تَغیف تاتع
هی هاًذ   1تاضذ خزٍجی تا پایاى ایي سهاى  1تزیگز فعال هی ضَد اگز تزیگز در سهاى تایوز تالا  1تِ  0تایوز تالا تا تغییز اس 

هیطَد تایوز پاییي فعال هی ضَد اگز ٍضعیت  0خزٍجی رٍضي ضذى ٍرٍدی راتا تاخیز دًثال هی کٌذ ٍقتی ٍرٍدی 
.هی هاًذ 0تاضذ در طَل تایوز پاییي خزٍجی تا پایاى سهاى تایوز پاییي  0تزیگز   

Trg 

TL 

Q 

TH 

 :دیاگرام

K1 

S1 K1 

M K2 

K2 

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 رلِ پاک کٌٌذُ تَلیذ کٌٌذُ پالس

 تا یک ًگاُ هی تَاى گفت کِ لاهپ رٍضي خَاّذ تَد تا سهاًی کِ کلیذ تستِ تاضذ

 ٍ تایوز فعال تاضذ

 ضوای ایي گیت در سیز آهذُ است

T1 

S1 

H1 

T1 

 تَغیف تاتع
تاقی هی هاًذ ٍقتی  تایوز تِ  1فعال هی ضَد ٍ خزٍجی ! هی ضَد تایوز  در لَگَ 1هیطَد خزٍجی فَرا  1ٍقتی تزیگز 

.خَاّذ رفت 0تِ  1هیطَد خزٍجی فَرا اس   0سهاى هطخع رسیذ خزٍجی   

Trg 

Ta 

Q 

 :دیاگرام
 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 لبِ تریگر رلِ پاک کٌٌذُ

T1 

S1 

H1 

T1 

T1 

 تَغیف تاتع
یک خَاّذ ضذ تایوز در آى سهاى رٍضي خَاّذ ضذ ٍقتی تایوز تِ سهاى هَرد  1خزٍجی تعذ اس تغییز ٍضعیت تزیگز تِ 

تغییز یاتذ قثل اس اتوام سهاى هَرد  1تغییز ٍضعیت خَاّذ داد خزٍجی پالس اگز تزیگز دٍتارُ تِ  0ًظز رسیذ خزٍجی تِ 
.ًظزتایوز ریست هی ضَد ٍ خزٍجی رٍضي هی هاًذ  

Trg 

Ta 

Q 

T T 

 :دیاگرام

 تا یک ًگاُ هی تَاى گفت کِ لاهپ تزای هذت هطخػی رٍضي هی هاًذ
  ٍقتی کلیذ تستِ ضَد

 ضوای ایي گیت در سیز آهذُ است

 تَاتع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 تایورّفتِ ای

.خزٍجی تِ ٍسیلِ تاریخ رٍضي ٍخاهَش ضذى تعییي هیگزدد  
ایي تاتع هیتَاًذ تزکیة ّای هتفاٍتی اس رٍسّای هختلف ّفتِ را 

.تا ّن ایجاد کٌذ  
.ضوا هی تَاًیذرٍس ّای هختلف ّفتِ را فعال ٍ اًتخاب کٌیذ  

 چْارضٌثِ

 دٍضٌثِ

:تَغیف تاتع  

ٍضعیت دارد کِ ضوا هیتَاًیذ یک  3ّز ّفتِ 
سیکل سهاًی تعزیف کٌیذ ٍ تایوزّای خاهَش ٍ 

 رٍضي ضذى را تعییي کٌیذ

Mon Tue Wed Thurs Fri Sa So On Off 

07 
:
    

30 16 05 Cam 1 

08 :    00 12 00 Cam 2 

10 :    00 12 30 Cam 3 

 تَاتع



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
 A&D AS, 02/2006, Chart 27 

    © Siemens AG 2006  -  Subject to change without notice 

 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

Timer – yearly timer 

:شرح عملكرد تايمر سالانه  

هر تايمر سالانه شامل يك تايمر روشن كننده و 

با تعيين زمان .يك تايمر خاموش كننده است

 روشن وخاموش شدن خروجي درروز مشخص

با انتخاب گزينه .شده روشن يا خاموش ميشود

"Every month "  
خروجي تعيين شده درهر ماه در روز مشخص 

. شده روشن يا خاموش ميشود  

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec 

On 05.10 Off 10.20 

15.05.2005 15.05.2005 08.11.2005 08.11.2005 

 توابع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

Timer – pulse generator 

 با تعيين عرض پا لس 
on  ٍ off  

. ميتوان خروجي را كنترل كرد  
.نماد شماتيك اين تابع در زير آمده است  . 

 

“ timer pulse generator “شرح عملكرد 
.بودن خروجي ميتواند در حد ثانيه يا دقيقه و يا ساعت باشد on  ٍ  off  

EN“يك باشد خروجي  “در زماني كه "  inv ” با يك شدن پايه  

.ميشود Toggle 

. مدت زمان روشن يا خاموش بودن خروجي به طور كامل مستقل است   

Diagram: 

En 

Q 

pulse period / pause width 

Inv 

 توابع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

Timer – stairway lighting switch 

 با اعمال پالس به ورودي خروجي يك شده

 15. وسپس بعد از زمان معيني صفر ميشود 

ثانيه قبل از صفر شدن خروجي در يك لحظه 

.كوتاه خروجي صفر و دوباره يك ميشود  

 .نماد شماتيك اين تابع در زير آمده است  

با اعمال اولين تريگر ، خروجي يك ميشود و با اعمال دومين تريگر زمان تاخيربراي 
ثانيه  1ثانيه قبل از صفر شدن خروجي به مدت 15.صفر شدن خروجي شروع ميشود

. صفر و دوباره يك ميشود  

Ta 

Trg 

Q 

T (OFF delay) 

1s 

15s 

Diagram: 

 توابع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

Counter – Up and Down counter 

تريگر جهت شمارش كانتر را اعمال  1با توجه به مدار معادل مشاهده ميشود كه كليد
زماني كه تعداد . بالارو يا پايين رو بودن شمارنده را تعيين ميكند 2ميكند و كليد

. يا بيشتر برسد خروجي يك ميشود 5شمارش كانتر به   

Cnt با اعمال هر پالس با لبه مثبت به پايه  

(Dir=1)  و يا يك رقم به سمت پايين(Dir=0) شمارنده داخلي يك رقم بالا 

  بعد از شمارش كانتر به ميزاني كه در. شمارش ميكند Par مشخص شده است ، 

. خروجي يك ميشود   

 با يك شدن پايه R .خروجي ونيز مقدار شمارنده داخلي صفر ميشوند

C1 

S1 

S2 

+ - 

>=5 

H1 

Diagram: 

Q 

Cnt 

Dir 

R 

1 
2 

3 
4 

5 
6 

5 
4 

3 
2 

3 
4 

5 
6 

0 
1 

2 
3 

Counter 

 توابع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

Counter – hours counter 

Description of the function: 

The hours counter monitors the input En. As long as the status of this input is 1, 
LOGO! determines the expired time OT and the time–to–go MN. LOGO! displays the 
times in parameter assignment mode. Output Q is set to 1 when the time–to–go MN 
= 0. Use input R to reset output Q and time–to–go counter to the specified value MI. 
The internal counter OT continues the count. Use input Ral to reset output Q and the 
time–to–go counter MN to the specified value MI. The internal counter OT is reset to 
0. 

1 
2 

3 
4 

3 
2 

1 
0 

MN = MI 

MN = 0 

Q 

Ral 

En 

3 
2 

1 
0 

R 

OT 

 توابع
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

Counter – threshold trigger 

يك و صفر شدن خروجي با اعمال پالس به 

ورودي ومقايسه فركانس اين پالس با دو 

.فركانس مشخص، كنترل ميشود   

.نماد شماتيك اين تابع در زير آمده است   

 در ابتدا اگر خروجي صفر باشد براي يك شدن خروجي بايد فركانس پالس

”on“باشد ودر اين وضعيت براي صفر شدن خروجي بايد  ورودي كمتر از فركانس   

.به ورودي اعمال شود   “off”  پالس با فركانس بيشتر از فركانس 

On: on threshold. .  باشد 9999تا0000ميتواند بين   

Off: off threshold.  باشد9999تا0000ميتواند بين.   

Gate time:       باشد95/99تا05/0ميتواند بين.  

Diagram: 

Fre 

Q 

gate  
time 

Fre > On Fre > Off Fre < Off Fre < On 

Fre =12 Fre = 5 Fre = 3 Fre = 5 

On = 10   Off = 4 توابع 
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 هثال کاربردی

Analog – analog threshold trigger 

خروجي زماني يك ميشود كه مقدارورودي 

آنالوگ از آستانه روشن شدن بيشتر شود 

و هنگامي كه مقدار ورودي آنالوگ از 

آستانه خاموش شدن كمتر شود خروجي 

آستانه روشن وخاموش . صفر ميشود 

باشد در ضمن 1000تا0شدن ميتواند بين 

.خروجي با ضريب بهره تقويت ميشود  

Diagram: 

 توابع
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 هثال کاربردی

Analog – analog comparator 

  دراين مقايسه گر تفاوت دو ورودي 
 آنالوگ AxوAyمحاسبه شده وهنگامي كه

تفاوت اين دو سيگنال از مقدار آستانه 

تجاوز كند خروجي يك ميشود و اگر مقدار 

تفاضل دو ورودي از مقدار آستانه كمتر  
  .  شود خروجي صفر خواهد شد

Diagram: 

 توابع
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 هثال کاربردی

Analog - analog differential trigger 

 يك ورودي آنالوگ به پايه Axاعمال ميشود

 كه اين سيگنال با يك مقدار مشخص مقايسه 

خروجي بر اساس مقادير آستانه . ميشود 

 روشن شدن (on)ونيز سيگنال تفاضلي

.صفر يا يك ميشود)   (  

.خروجي با ضريب بهره تقويت ميشود  
Diagram: 

Timing diagram A: Function with negative differential delta value 

Timing diagram B: Function with positive differential delta value 

 توابع
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 هثال کاربردی

Analog – analog watchdog 

  هنگامي كه پايه ”En“از صفر به يك تغيير 

 وضعيت بدهد مقدار سيگنال وروديAxدر اين 

  لحظه ذخيره ميشود كه ”Aen“نام دارد ، با 

 اضاف و كم كردن يك مقدار ثابت از”Aen“دو 

 مقدار ثابت“   -Aen”و“   +Aen“به دست 

  اگر پايه.مي آيد  ”En“يك باشد وسيگنال 

“Aen+   “ٍ”Aen-   “ از محدوده“Ax” 

.تجاوز كند خروجي يك مي شود  Diagram: 

 توابع
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 هثال کاربردی

Analog – analog amplifier 

Ax اين تابع يك سيگنال ورودي را از پايه    

 دريافت و آن را با ضريب بهره تقويت مي كند 

 سپس يك مقدار آفست نيز به آن اضافه مي كند

.اين مقدارنهايي به دست ميآيد AQ در خروجي  

 توابع
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 هثال کاربردی

Analog – PI controller 

Description of the function: 

If the input A/M is set to 0, then the special function 
sets output AQ with the value that is set with 
parameter Mq. If the input A/M is set to 1, then 
automatic mode commences. As an integral sum the 
value Mq is adopted, the controller function begins the 
calculations of the formulas.  
The updated value PV is used within the formulas. 
Updated value PV = (PV * gain) + offset 
If the updated value PV = SP, then the function 
does not change the value of AQ. With a disturbance, 
AQ continues to increase / decrease until the updated 
value PV again corresponds to SP. The speed with 
which AQ changes depends on the parameters KC and 
TI. If the input PV exceeds the parameter Max, then 
the updated value PV is set to the value of Max. If the 
PV falls short of the parameter Min, then the updated 
value PV is set to the value of Min. If the input R is set 
to 1, then the AQ output is reset. As long as R is set, 
the input A/M is disabled. The sampling time is fixed at 
500 ms. 

 توابع
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 هثال کاربردی

Analog – PI controller 

Parameter: 
Sensor: Type of sensor used 
Min: Minimum value for PV 
Max: Maximum value for PV 
Gain: Gain for PV 
Offset: Zero offset for PV 
SP: Set point assignment 
Mq: Value of AQ in manual mode 
Parameter sets: applied presets for  
KC, TI and Dir 
KC: Gain 
TI: Integral time 
Dir: Action direction of the controller 
Number of decimal places in 
message text 

 توابع
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 هثال کاربردی

Analog – PI controller 

parameter sets: 
”pl controller“پارامترهاي از قبل   جهت ساده كردن استفاده از تابع

.در زير آورده شده است KC,TI,Dir آماده شده براي  

.پارامترها به صورت دستي نيز مي توانند تعيين شوند   

Parameter sets “user defined” 

Parameter 
Set 

Applications 
Parameter 

KC 
Parameter 

TI (s) 
Parameter 

Dir 

Temperature 
fast 

Temperature, low temperature 
control for small rooms; small 
volumes 

0.5 30 + 

Temperature 
slow 

Heater, ventilation, temperature, 
low temperature control for large 
rooms, large volumes 

1.0 120 + 

Pressure 1 
Fast pressure change, 
compressor control 

3.0 5 + 

Pressure 2 
Slow pressure change, 
Differential pressure control 
(flow control) 

1.2 12 + 

Filling level 1 
Barrel, container filling without 
downpipe/ drain 

1.0 1 + 

Filling level 2 
Barrel, container filling with 
downpipe/ drain 

0.7 20 + 

 توابع
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 هثال کاربردی

Analog – ramp 

Description of the function: 

At the analog output, this special function starts up one 
of two levels or offset. Here you can set how quickly the 
level should be reached. 
If the input En is set, then the function issues the value 
StSp + offset at output AQ for the first 100 ms. 
Then, depending on the connection of Sel, the function 
runs from value StSp + offset to either level 1 or level 2 at 
the acceleration set in Rate. 
If the input St is set, the function runs to the value StSp + 
offset at the acceleration set in Rate. Then the function 
issues the value StSp + offset at output AQ for 100 ms. 
Finally offset is issued at output AQ. 
If the input St is set, the function can only be restarted 
once the inputs St and En have been reset. If input Sel 
has been changed, depending on the connection of Sel, 
the function runs from level 1 to level 2 or the other way 
round. If the input En is reset, the function immediately 
issues offset  at output AQ. The analog value at the 
output is recalculated every 100 ms. 

 توابع
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 هثال کاربردی

Analog - ramp 

Parameter: 
Gain: Gain for AQ in message text 
Offset: Zero offset for AQ in message 
text 
L1 and L2: Levels to be reached  
Maximal output value: Maximum value 
that must not be exceeded under any 
circumstances 
Start/ stop offset: value that is issued for 
100ms in addition to parameter 
offset after starting the function 
and before reaching the offset value 
(prompted by input St). This parameter 
is intended for controlling motors. 
Change speed: Acceleration with which 
level 1, level 2 or offset is reached. 
Steps/ second are input. 
Number of decimals 

 توابع
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 هثال کاربردی

Analog - ramp 

Diagram: 

 توابع
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 هثال کاربردی

Analog – analog MUX 

v1 ويا  تا  v4خروجي اين تابع وي   ژه يكي از چهار مقدار آنالوگ از پيش تعيين شده 

  اگر پايه.صفر خواهد بود  ”En“يك باشد يكي از چهار مقدار آنالوگ با توجه به   

 مقادير S2وS1 در خروجي AQ و اگر پايه ظاهر ميشود ”En“صفر باشد خروجي 

.را به دلخواه انتخاب كرد V1تاV4 ميتوان مقاديرآنالوگ.نيز صفر خواهد بود  

 توابع
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 هثال کاربردی

Miscellaneous – latching relay 

k1با    با توجه به مدار معادل مشاهده مي شود كه كويل

.وصل ميشود  S1كليد 

.نماد شماتيك اين تابع در زير آمده است  
S2 

K1 M 

S1 K1 K1 

K2 

. ميكند  Reset راQ خروجي R و ورودي Set را Q  خروجيSورودي 

S 

R 

Q 

Diagram: 

 توابع
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 هثال کاربردی

Miscellaneous – pulse relay 

  با دادن هر پالس به ورودي Trgخروجي از يك به صفر يا از صفر به يك تغيير  

.خروجي را صفر كرد  R  ميتوان با اعمال يك پالس به پايه. وضعيت ميدهد  

با توجه به مدار معادل مشاهده مي شود كه لامپ  H با   

به عبارت . روشن يا خاموش ميشود S1 يا S2 كليدهاي 
S2ياS1باعث روشن وخاموش شدن   ديگر يك پالس كوتاه

.لامپ ميشود  

.نماد شماتيك اين تابع در زير آمده است  K1 

S1 K1 S2 

H1 

Trg 

R 

Q 

Diagram: 
 توابع
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 هثال کاربردی

Display of a configured message text in run 
mode. 

Symbol for this function is         .  

Miscellaneous – message text 

Description of the function: 

With a 0 to 1 transition of the  input signal 
and when the system is in RUN, the 
corresponding message text is output to 
the display. The message text is hidden 
when the status of the signal at input 
changes from 1 to 0. When multiple 
message text functions are triggered with 
En=1, the message text that has the 
highest priority is shown. Changing 
between the standard display and the 
message texts display is possible by using 
the keys and            .  If “acknowledge 
message” is chosen, the respective 
message text will be hidden by pressing 
any key on LOGO!, if En=0. 

LOGO 
OK 

1 2 3 4 

s 

Motor on 

 

ESC 

I : 
0..  123456789 
1..0123456789 
2..01234 

Alarm! 
Current Temp 
    97  °C 

 توابع
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 هثال کاربردی

Miscellaneous – softkey 

Diagram: 

 اين تابع عملكردي شبيه pushbuttonيا كليد 

Enاگرپارامتر  بااعمال سيگنال به پايه. دستي دارد  

“set” باشد خروجي “on” در وضعيت“switch” 

:ميشود “Reset”   خروجي در سه حالت زير.ميشود

.از صفربه يك   En 1.بعد ازتغيير وضعييت پايه 

.زماني كه دوره يك بودن خروجي تمام شود .  2 

“switch” در پارامتر “off” .وقتي كه وضعيت  3 

.  انتخاب شده باشد  

 توابع
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 هثال کاربردی

Miscellaneous – shift register 

اين تابع يك شيفت رجيستر است كه داراي 

. هشت بيت حافظه مي باشد  

  با اعمال پالسهاي متوالي به پايه Trgمقادير 

 حافظه هاي S1تاS8به خروجي انتقال ميابند 

حال اگر پالسهاي ورودي قدرت كافي نداشته 
از اول   S8 تاS1 باشند شيفت دادن محتواي  

.شروع ميشود   

.نماد شماتيك اين تابع در زير آمده است  

Diagram: 

Shift 
up 

Shift 
down 

S4 = Q (example) 

 توابع
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 هثال کاربردی
تفسير ميکند   OR  را يک گيت 2و  1لوگو موازی شده دو کليد  

 اولین برنامه لوگو شما

به کار می افتد   s2   بار با s1 يا 

.موازي است را بررسي مي كنيم “switch”  اكنون مدار زير كه شامل دو 

>1 
I1 
I2 

X 

Q1 

  راه حل لوگو

X 

S1 S2 

K1 

K1 

E1 

 مدار

•  •  •  

•  

•  •  

 عملکرد دستگاه
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 هثال کاربردی

 سیم کشی

وصل  2به ورودی  2و کليد  1به ورودی  1کليد   

متصل است 1است و بار به خروجی   

در ابتدا روی.حال برنامه را به لوگو وارد ميکنيم  

نشان داده ميشود علامت 1صفحه نمايشگر خروجی   

.چشمک زن موقعيت کنونی ما را مشخص ميکند  

•  

L1 

N 

S1 

LOGO! 230RC 

OK 

Q1 

  I1   I2  I3   I4  I5  I6 L1 N 

Q1 Q2 Q3 Q4 

S2 

L1 

N 

s 

 I7  I8 

•  •  

ESC 

•  

E1 

 عملکرد دستگاه
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 هثال کاربردی

 برنامه کامپیوتری لوگو

Windows Look and Feel  
 e.g. context menu, toolbar 

Create the control programs by „drag and drop“ 
 Control programs „drawing“ –  

directly on a PC in FBD or LAD 

Testing of control programs 
 Offline simulation 

with status for each function  
(color change) 

 Online test with color change  
for each function 
and 30 actual values 

Professional print and  
documentation functions 
Device selection 
 0BA0, 0BA1, 0BA2, 0BA3, 0BA4, 0BA5 

 with function check 

Additionally on the CD ROM:  

Manual and 32 complete, usable examples 

 A&D AS, 07/2003, Chart 52 
     © Siemens AG 2003  -  Änderungen vorbehaltenc 
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 هثال کاربردی

 نصب برنامه لوگو

 سی دی لوگو را در کامپيوتر قرار دهيد 
.را انتخاب کنيد   start.html پس از ورود 

2. 

3. 

5ويرايش ! نرم افزار لوگو  
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 هثال کاربردی

 نصب برنامه لوگو

Start.html توابع 
زبان 7انتخاب مستقيم   

 نصب برنامه
 اجرای مستقيم برنامه از سی دی

 
 انتخاب مسايل نمونه از سی دی

 نصب برنامه های مورد نياز

5ويرايش ! نرم افزار لوگو  
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 هثال کاربردی

 نصب برنامه لوگو

 آغاز نصب برنامه
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و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
 A&D AS, 02/2006, Chart 56 

    © Siemens AG 2006  -  Subject to change without notice 

 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 نصب برنامه لوگو

را انتخاب کنيد   next پس از انتخاب زبان و تاييد در پنجره بعدی نيز  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
 A&D AS, 02/2006, Chart 57 
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 نصب برنامه لوگو

 برنامه به صورت پيش فرض در آدرس زير نصب می شود
C:\Program Files\Siemens\LOGOComfort_V5 

 اگرمی خواهيد آدرس را تغيير دهيد 
Browse 

 هروقت با آدرس نوشته شده در کادر موافق بوديد
Next 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 نصب برنامه لوگو

 آيکون برنامه روی دسک تاپ              است
 Ok را انتخاب کنيد 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 نصب برنامه لوگو

می توانيد با انتخاب آيکون برنامه روی دسک تاپ آن را اجرا کنيد.نصب برنامه تمام است  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 نگاهی کلی به برنامه لوگو

Title bar 

Menu bar 

Symbol bar for  
program installation 

Switch to selecting mode 

Text fields for additional  
comments 

For a better overview 
separation of connections 

Drawing of connection lines 

Display connectors (Co) 

Display basic functions (GF) 

Display special functions (SF) 

Offline simulation 

Standard Windows PC -> LOGO! LOGO! -> PC! 

Online test 

Tree structure for fast choice 
of all generation elements 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 راهنمایی

با کليک موس روی هر موضوع 

 دلخواه ميتوانيد جزئيات آن را ببينيد

از طريق زير ميتوانيد راهنمايی دريافت کنيد   
Help -> Content 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 راهنمایی مستقیم

برای دريافت راهنمايی مستقيم روی 

  تابع مورد نظر کليک راست کنيد

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 راهنمایی مستقیم

 از مسير زير هم می توانيد راهنمايی مستقيم دريافت کنيد
Help -> Context-sensitive Help 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

ارتقاء-راهنمایی  

از طريق زير ميتوانيد برنامه خود را ارتقا 
دهيد و قابليت های جديد به آن اضافه 

(مثلا زبانهای جديد)کنيد  
Help -> Update Center. 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 وظایف نمونه لوگو

 کنترل مخزن آب

  (Q1)  افت کند منبع آب آشاميدنی (I1) وقتی سطح آب به زير 

I2 وقتی سطح آب به. به طور اتوماتيک شروع به کار ميکند   
.برسد منبع آب به طوراتوماتيک قطع می شود  

P 

I3 (Pump OFF) 

I1  
(drinking water     
supply ON) 

I2  
(drinking water            
supply OFF) 

I4  
(Pump OFF) 

Q1  
(drinking water supply) 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

(CO) واردکردن اتصالات :قدم اول  

  برای انجام کار به چند ورودی و خروجی احتياج داريم؟

 به وسيله ساختار درختی سمت چپ برنامه ميتوانيد سريعا همه بلوک

 های ورودی و خروجی و تمام توابع و ملزومات ديگر را انتخاب کنيد

 و آنها را در جای خود قرار دهيد
 

  بعد از انتخاب المان مورد نظرعلامت زير ظاهر می شود
 
 

المان در انجا جای ميگيرد.به محل مورد نظر رفته و کليک چپ کنيد  

1. 

2. 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

وارد کردن توابع پایه: قدم دوم   

  چه توابع ساده ای برای حل مساله مورد نياز می باشد؟

در صفحه 1و خروجی  2و  1بعد از قرار دادن هردو ورودی   
مطابق آنچه گفته شد.احتياج داريم   NOT يک تابع ساده  

 ان را از سمت چپ انتخاب کرده و در جای خود قرار دهيد

1. 

5ويرايش ! نرم افزار لوگو .2  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

وارد کردن توابع خاص: قدم سوم   

  به چه توابع خاصی نياز داريم؟

نيز نياز داريم   latching relay 1  به يک. 

2. 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

Step 3: Insert special functions (SF) 

.را معکوس کرد   latching relay  در اين برنامه می توان به جای استفاده از  NOT  پايه 

 با کليک راست می توان با انتخاب گزينه اول پايه را معکوس کرد

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

اتصال: قدم چهارم  

 حالا بايد بلوکها را به هم متصل کرد

 با نشانگر ماوس می توان به صورت مستقيم اتصال ها را در هنگام جايگزينی بلوکها برقرار کرد

.در غير اين صورت بايد ابزار           را انتخاب کنيد  

 نشانگر ماوس را به کنار پايه اتصال بلوک منتقل کنيد و کليک چپ کنيد و بدون برداشتن دست خود 

 از روی ماوس آن را به پايه ای که می خواهيد برده و ان را رها کنيد 

1. 

2. 
5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

                                                    اتصال: قدم چهارم 

:                                      برای کامل کردن مدار کنترلی بايد بلوک ها را به يکديگر متصل کنيد  

اما اگر در وضعيت .به طور معمول ميتوانيد بعد از قرار دادن بلوک آن را توسط نشانگر وصل کنيد

.ديگری قرار داريد بايد ابزاری را برای متصل کردن انتخاب کنيد  

و ( يک جعبه کوچک آبی رنگ نشان داده می شود)اکنون نشانگر را روی پايه اتصال حرکت دهيد 

همزمان که کليک را فشار می دهيد نشانگر را به سمت پايه ای که .کليک چپ موس را فشار دهيد

همين کار . اتصال نمايان می شود.ميخواهيد اتصال دهيد، حرکت دهيد سپس کليک موس را رها کنيد

. را برای ديگر اتصال ها تکرار کنيد  

  

1. 

2. 
5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

اضاف کردن متن                                           : قدم پنجم   

.با اضاف کردن متن بر روی پس زمينه ، برنامه شما قابل فهم تر می شود  

:برای اين کار راههای متفاوتی در ساختار برنامه قرار دارد  

قرار دادن عبارت در هر بلوک برنامه توسط منوی 

(کليک چپ موس)متن  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

قرار دادن زمينه متن                                     : قدم پنجم   

A 

 با قرار دادن يک زمينه دارای متن

1. 

2. 

4. 

3. 
5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

نام گذاری اتصالات                                      : قدم ششم   

.          به منظور خوانا تر شدن برنامه ، می توان نامهايی را برای ورودی و خروجی ها در زمينه متن قرار داد  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

                                       جابه جا کردن المانها: قدم هفتم 

. برنامه کنترلی با قرار دادن ساختار بلوک ها و اتصال آنها کامل می شود Placed objects such as function 
blocks, lines, and text fields can be moved accordingly. 

 اين ابزار       برای جابجايی به کار 

.می رود  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

رديف کردن                                               : قدم هشتم   

اين دکمه        برای رديف کردن بلوک های انتخاب شده به 

.صورت عمودی می باشد   

.                                         برای طراحی بهتر می توانيد بلوک ها را در رديف های افقی يا عمودی قرار دهيد   

برای رديف کردن بلوک ها ، ابتدا بايد آنها را انتخاب 

.کنيد  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

                                     پارامتر گذاری بلوک ها: قدم نهم 

.                                                        در اينجا می توانيد تنظيمات مربوط به هر تابع مخصوص را انجام داد  

بلوک تابع را انتحاب کنيد ، با زدن کليک راست موس گزينه 

.منو را انتخاب کنيد  

.دو بار کليک چپ موس را بر روی بلوک تابع فشار دهيد  

در پيکربندی ،آدرس ديگری می تواند برای هر 

تنها  . ورودی و خروجی يک بلوک ، معين شود

ورودی ها و خروجی هايی  را در بر می گيرد که 

.  هنوز در برنامه کنترلی نامگذاری نشده اند  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

پارامتر گذاری بلوک ها: قدم نهم   

.ضمنأ اين امکان هم وجود دارد که نشانه همه بلوک ها را چک و يا عوض کنيم  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

قالب بندی متن ها: قدم دهم   

.  متن ها و عبارات توسط کاربر ، می تواند تغيير کند قالب بندی زمينه    

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

اسناد و مدارک: قدم يازدهم   

.برای مستند سازی برنامه ، تمام اتصالات بکار برده شده ، توابع مخصوص و توابع اصلی  قابل نمايش می باشد  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

اسناد و مدارک: قدم يازدهم   

اطلاعات بيشتری در باره اسناد و مدارک برنامه را می توان در پنجره اطلاعات مشاهده کرد که به صورت يک دکمه پيش 

.فرض قرار داده شده است  

شما می توانيد در هر زمانی توسط منوی                           به 

.پنجره اطلاعات دسترسی پيدا کنيد  

در پنجره اطلاعات مرجع استفاده شده در برنامه ، با زمان و تاريخ 

.آن نمهيش داده می شود .  

5ويرايش ! نرم افزار لوگو  

View -> Info Window 



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

اسناد و مدارک: قدم يازدهم   

.اطلاعات و محيط برنامه را می توان مطابق شکل زير مشاهده کرد  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

اسناد و مدارک: قدم يازدهم   

The program including the entered plant data can be viewed from the attribute 
window under File -> Print preview. 

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

اسناد و مدارک: قدم يازدهم   

شما می توانيد اسناد و مدارکی را که می خواهيد چاپ کنيداز طريق گزينه                     در پنجره                  

توسط  پيش فرض قرار دادن  دياگرام مداری، ليست پارامترها و ليستی شامل نام اتصالات انتخاب خواهد . انتخاب کنيد

. شد  

5ويرايش ! نرم افزار لوگو  

Properties… print preview 



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

اسناد و مدارک: قدم يازدهم   

 اين امکان وجود دارد تا دياگرام مدار را به صفحات بزرگتر تقسيم کرد

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

اسناد و مدارک: قدم يازدهم   

.در ضمن پياده سازی برنامه بر روی صفحات مختلف ممکن است لازم شود که خطوط اتصال جدا شوند  

تداخل ها به وضوح توسط شماره صفحه ، شماره بلوک و پايه . اتصالات را می توان به سادگی توسط انتخاب گزينه برش، از هم جدا کرد

.   ورودی برپسب گذاری شده است  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

تست کردن برنامه: قدم دوازدهم   

. بعد از پيکر بندی و اسناد و مدارک ، قدم بعدی، تست برنامه توسط شبيه ساز است  

.  اما هنوز شما بايد عملکرد برنامه خود را مطابق آنچه انتظار داريد چک کنيد. اکنون شما می دانيد که برنامه می تواند در لوگو اجرا شود

شما می توانيد به راحتی مقادير ورودی ها ، نحوه عملکرد قسمت های مختلف را از .شايد قصد داشته باشيد تا پارامتر هايی  را عوض کنيد

.   طريق محاسبه و آنچه در خروجی آنها داريد، با هم مقايسه کنيد  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

تست کردن برنامه: قدم دوازدهم   

.يک ابزار بسيار کارامد برای چک کردن برنامه موجود می باشد  

اين ابزار            را هنگامی 

انتخاب کنيد که می خواهيد برنامه 

با انجام عمليات . را چک کنيد

شبيه ساز يک خط ابزار برای 

مشاهده و نحوه عملکرد خروجی 

.  و ورودی ها انتخاب می شود  

با کليک کردن بر روی خط ابزار 

و يا بر روی ورودی ها در 

دياگرام مدار ، ميتوانيد وضعيت 

.  ورودی ها را عوض کنيد

سيگنالها ی موجود در خطوط 

اتصال را می توان با تغيير دادن 

(  لبه پايين سيگنال)رنگ از آبی 

لبه بالا ی )به رنگ قرمز 

اين کار باعث .نشان داد( سيگنال

می شود تا خطا يابی بسيار آسان 

. شود  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

تست کردن برنامه: قدم دوازدهم   

.از مزايای تست کردن برنامه اين است که هر ورودی می تواند به يک سوييچ اختصاص داده شود  

شما می توانيد . به يک سوييچ خاص اختصاص داد( کليک راست موس) هر يک از ورودی های بلوک ها را توسط منوی متن ورودی بلوک 

اگر کليد ورودی های فرکانسی را انتخاب کنيد ، . از بين کليدهای فشاری و ورودی های فرکانسی ،در ورودی های ديجيتال انتخاب کنيد

با ورودی آنالوگ مقدار رنج و مقدار شروع را می توان تنظيم . فرکانس های شبيه سازی شده می توانند در فرکانس های مختلفی تنظيم شود

. تمام اين تنظيمات در منوی                                              قرار دارد. کرد  

5ويرايش ! نرم افزار لوگو  

Tools -> Simulation parameters. 
 



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

قرار دادن کلمه رمز: قدم سيزدهم   

.برای محافظت از برنامه خود می توانيد يک عدد ده رقمی را به عنوان کلمه رمز قرار دهيد  

به طوری که بدون نياز به کلمه رمز ! اين کلمه رمز برنامه شما را فقط در لوگو محافظت می کند

برای پاک کردن کلمه رمز قبلی  وارد گزينه                  . می توانيد آن را پاک و يا مشاهده کنيد

.شويد و                         را خالی بگذاريد  

کلمه رمز زمانی گم می شود که کلمه رمز سه بار ! برای آنکه بتوانيد دوباره از لوگو استفاده کنيد 

.  در اين حالت برنامه به صورت خودکار پاک می شود. به طور اشتباه وارد شود  

5ويرايش ! نرم افزار لوگو  

Old password 

New Password 
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!لَگَ  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

انتقال برنامه به لوگو: قدم چهاردهم   

اين امکان برای شما وجود دارد که ابتدا دياگرام مدار خود را تحليل کنيد سپس وسايل مورد نياز را توسط گزينه            

و يا می توانيد ابتدا توسط                                  وسايلی را که نياز داريد .مشخص کنيد                                

.                       تا مدار خوذ را ببنديد ، مشخص کنيد  

در انتخاب قطعات می توانيد در تمامی انواع لوگو ، مرجع آنها را 

که )تمامی بلوک های تابع و مراجع  در پيکر بندی . مشاهده کنيد 

. ارائه شده است( به نوع ويرايش بستگی دارد  

5ويرايش ! نرم افزار لوگو  

Tools -> Determine LOGO Tools -> Select Hardware 



و راه اندازی اتَهاسیَى  

!لَگَ  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

انتقال برنامه به لوگو: قدم چهاردهم   

اگر اتصال بين لوگو و رايانه نتواند به درستی برقرار 

.شود ، پيغامی نمايان می شود  

برای اين منظور لوگو را بايد توسط کابل به . بعد از اينکه برنامه شما با موفقيت چک شد بايد آن را به لوگو انتقال دهيد

.رايانه متصل کرد  

به مجرد انتقال موفقيت آميزپيغامی  بر روی 

.خط وضعيت مشخص می شود  

شما بايد بر روی گزينه         کليک کنيد تا دياگرام 

قبل از انتقال دادن ، . مدار شما به لوگو منتقل شود

ويرايش لوگو برای برنامه مدار پيکر بندی شده بايد 

اگر برنامه مدار پيکر بندی شده نتواند . مشخص شود

بر روی لوگو منتقل شود ، پيغام خطايی نمايان می شود 

.    و انتقال صورت نمی گيرد  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

راه اندازی لوگو: قدم پانزدهم   

P 

I3 

I1 

I2 

I4 

Q1 

LOGO! 12/24 RC 

LOGO!  

OK ESC 

  Program.. 

  Card.. 

  Setup.. 

  Start 

> 

s 
LOGO! 12/24 RC 

LOGO!  

OK ESC 

  Program.. 

  Card.. 

  Setup.. 

  Start > 

s 
LOGO! 12/24 RC 

LOGO!  

OK ESC 

I :        

0..  123456789 

1..0123456789 

2..01234 

s 

سپس برنامه می . بعد از اينکه برنامه را بر روی لوگو انتقال داديد بايد لوگو را بر روی حالت                 قرار گيرد

.تواند اجرا شود  

5ويرايش ! نرم افزار لوگو  

RUN-mode 
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!لَگَ  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

تست آنلاين: قدم شانزدهم   

علاوه بر شبيه سازی که می تواند انجام گيرد ، يک تست آنلاين نيز بعد از انتقال برنامه بر روی لوگو می تواند انجام 

.گيرد  

1. 
2. 3. 

به منظور فعال شدن تست آنلاين پس از انتقال 

برنامه بر روی لوگو اين گزينه          را انتخاب 

سپس برای قرار گرفتن لوگو در حالت         . کنيد

برای .ران ، از اين گزينه             استفاده کنيد 

مشاهده کردن وضعيت آنلاين بايد سمبل عينک      

اکنون شما می توانيد توسط دادن .فعال شود  

.      ورودی هايی برنامه خود را شبيه سازی کنيد

    

5ويرايش ! نرم افزار لوگو  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

تنظيم ساعت: قدم هفدهم   

.دهيد انجام را کا اين وسيله خود روی از مستقيم بطور توانيد می البته .کنيد تنظيم را لوگو سيستم ساعت توانيد می شما  

لوگو و رايانه بايد با کابل به يکديگر متصل شوند تا تنظيمات 

سپس بر روی گزينه آن .ساعت بر روی لوگو منتقل شود

.کليک کنيد  

5ويرايش ! نرم افزار لوگو  



و راه اندازی اتَهاسیَى  

!لَگَ  

Logic Module LOGO!  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

تنظيم ساعت: قدم هفدهم   

اين کار را از طريق نرم افزلری و يا از روی . اين قابليت برای شما وجود دارد که با لوگو يک ساعت اتوماتيک بسازيد

.خود وسيله می توانيد انجام دهيد  

لوگو و رايانه بايد با کابل به يکديگر متصل شوند تا تنظيمات ساعت 

.اتوماتيک که به کشور انتخابی بستگی دارد بر روی لوگو منتقل شود  . 
5ويرايش ! نرم افزار لوگو  
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 تنظيمات متفرقه

.تنظيمات متفرقه ديگر توسط اين گزينه                         می تواند انجام گيرد  

5ويرايش ! نرم افزار لوگو  

Tools -> Options 
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!لَگَ  

Logic Module LOGO!  
 A&D AS, 02/2006, Chart 98 

    © Siemens AG 2006  -  Subject to change without notice 

 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 مثال های کاربردی

 کنترل حامل

 مثال کاربردی
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

 کنترل حامل
 

:تعريف تابع   

.يک بطری که حامل را پر ميکند می تواند کنترل شود  

 قسمت اول

وقتی که کنترل حامل روشن می شود موتور . کنترل حامل توسط سوييچ       خاموش و روشن می شود
.موتور توسط سوييچ      می تواند خاموش شود.حامل فعال می شود  

 قسمت دوم

سپس موتور به کار . وقتی که سنسور     بطری را مشاهده کرد موتور به مدت سه ثانيه خاموش می شود
. خود ادامه می دهد  

I1 (ON) 

I3 (OFF) 
I2 (filling) 

Q1 

 مثال کاربردی

(I1). 

(I3) 

(I2) 
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

کنترل حامل قسمت اول: راه حل   

:تعريف تابع   

 قسمت اول

وقتی که کنترل حامل روشن می شود موتور حامل فعال می . کنترل حامل توسط سوييچ       خاموش و روشن می شود
موتور توسط سوييچ        می تواند خاموش شود .شود  

I1 (ON) 

I3 (OFF) 
I2 (filling) 

Q1 

 مثال کاربردی

(I1). 

(I3) 
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 هقذهِ

 ًصب ٍ سین بٌذی

 تَابع

 عولکرد دستگاُ

5ٍیرایص ! ًرم افسار لَگَ  

 هثال کاربردی

کنترل حامل قسمت دوم: راه حل   

I1 (ON) 

I3 (OFF) 
I2 (filling) 

Q1 

Edge triggered 
wiping relay 

 مثال کاربردی

(I2) 

: تعريف تابع   

 قسمت دوم

 

Part 2 سپس موتور به کار خود . وقتی که سنسور        بطری را مشاهده کرد موتور به مدت سه ثانيه خاموش می شود

  .ادامه می دهد
(I2) 


